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Editorial
A recent paper in Trends in Ecology and Evolution
by two Brazilian scientists, Carbayo and Marques (doi:
10.1016/j.tree.2011.01.004) estimated the cost of describ-
ing the entire animal kingdom at $263 billion USD. While
at first glance this looks prohibitively expensive, spread
out over several countries and several decades, it starts
looking achievable. In addition, comparing this figure
with other institutions, we find that it is approximately a
quarter of the total annual revenue gathered by the top
three petroleum companies (ExxonMobil, Royal Dutch
Shell and BP), half of annual US defence budget, and
two thirds of the estimated annual value of the illicit drug
trade. In the Australian context, it is 20 times the 2010
profit registered by BHP Billiton, and 10 times the com-
bined 2010 profit of the ten largest Australian compa-
nies (http://tinyurl.com/3geg4cd). This sort of money is
in circulation and is being turned over by endeavours ar-
guably less justifiable than species discovery. The sci-
entific acheivement of documenting the world’s animal
fauna and the evolutionary and ecological insights it will
provide, not to mention the discovery of extra food, phar-
macological, biomimetic and genetic resources, makes
this sum of money a worthwhile investment.

Samuel Brown

SASB General Meeting

The next General Meeting of the Society will be on Wednesday, 7 December 2011 during
the joint SASB/Invertebrate Biodiversity and Conservation Conference (http://ibcc2011.org/) in
Melbourne at the tentative time of 5 pm. General Meetings are the Society’s only face-to-face
membership events, and all members are welcome to attend. There will be reports from the Pres-
ident and the Treasurer, and elections for officers and Council. Please contact secretary Andrew
Thornhill (Andrew.Thornhill@anu.edu.au) if you would like to add general business items to the
agenda.

Bob Mesibov
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Adventures of an early-career systematic biologist

My PhD thesis examined aspects of the phylogeography and evolutionary history of
burrowing crayfish species in Australia at a range of evolutionary scales. To fully
understand current phylogeographic patterns of these freshwater species, we needed
to understand not only current connections between river systems and river basins,
but also to integrate information about ancient riverine connections and drainage re-
arrangements. The identification of these connections is particularly challenging in
coastal catchments adjoining shallow seas such as Bass Strait, where ancient river-
ine systems existed during marine lowstands, linking a terrestrial landscape containing
freshwater habitats between Victoria and Tasmania. Bass Strait is now a shallow sea-
way approximately 350 km wide and 500 km long with an average depth of 60 m.
Based on present-day bathymetric data, lowstands large enough to link Victoria and
Tasmania were likely restricted to within the last 10 million years. Developments in
GIS and recent advances in seafloor mapping data allow the simulated re-construction
of palaeo-coastline and corresponding drainage models, enabling testing of hypotheses
of faunal contractions and migrations across present-day shallow seas. The analysis of
high resolution seafloor information by Dr Daniel Ierodiaconou revealed a system of
remnant, now marine-inundated palaeo-drainage systems within the continental shelf
between Victoria and Tasmania. My analyses showed that these palaeo-drainage sys-
tems have likely facilitated inter-population connectivity of freshwater crayfish species
with distributions that span Bass Strait (i.e., those species present in Victoria and neigh-
bouring islands such as King Island and Tasmania) (Figure 1). Daniel, Dr Craig Sher-
man and I are presently furthering this research, examining the phylogeography of
Geocharax gracilis trans-Bass Strait.

My research also examined the deeper intra- and intergeneric phylogeny of the Aus-
tralian burrowing freshwater crayfish genera Geocharax, Gramastacus, Tenuibranchiu-
rus, Engaeus and Engaewa. Geocharax and Gramastacus were found to monophyletic
genera, while Engaeus is nonmonophyletic with E. lyelli most likely representing an
undescribed genus. Generic level diversification among these genera coincides with
the mid Miocene aridification of Australia and there is a sister relationship between
Engaewa in southwestern Australia and the other four genera in eastern and southeast-
ern Australia, despite populations being isolated in the present day by over 3000 km of
mostly desert to the West, or by the Great Dividing Range on the East coast.

After finishing my Ph D in 2009, I had the rare opportunity to continue my field ex-
plorations outside of Australia, collecting freshwater crayfish in Enaratoli in Papua
(Indonesia, the island of New Guinea). There we encountered amazing people and ter-
rain, but also suspicious locals who have been through upheavals with OPM (Papuan
Independence Movement), Christians, mining companies and the Indonesian invasion.
The local people seem to be afraid of losing further control of their homeland. Despite
our biological research team being registered with and accompanied by local police,
paying for samples, and being accompanied by Cenderawasih University staff and a
local elder, it was very difficult to collect samples and at one stage we encountered
angry Papuan locals, one of whom punched our guide in the head and attempted to
assault him with two machetes. After resolving this confrontation, our expedition team
had to “stand trial” in the village of Tigi. That is, from the local police station balcony
we addressed a waiting crowd of around 300 onlookers from the local community. We
needed to tell them that we were there for conservation biology, not mining, and they
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Figure 1. Engaeus sericatus and the palaeodrainages of Bass Strait (Schultz et al 2008).

requested from us that we return some of our samples to their respective localities. The
negotiations were translated between English, Indonesian and local Papuan languages
by local elders, and we were greeted by half the community screaming abuse and the
other half smiling and seemingly supporting our actions, all the while police standing
guard for us armed with AK47s and Uzi machine guns. This was a memorable event
but I have to admit it was slightly sketchy in the midst of it all. I would advise foreign
researchers sampling in Papua to stay in the villages and pay the locals to collect the
samples.

Post-studies, I also had the lucky opportunity to work in Antarctica (my second visit),
working as a field assistant to Alejandro Velasco-Castrillon, a PhD student from the
University of Adelaide. We spent a lot of time in the field, dropped by helicopter in
remote locations to camp out in tents, bivvy bags and field huts. Our mission was
to sample nematodes, rotifers, tardigrades, cladocerans and mites from soil and lakes
in ice free areas. Geological studies indicate that the sample sites have been ice-free
even throughout glacial maxima, so present day, resident micro-invertebrates may rep-
resent ancient populations. Examination of their DNA sequences presents an amazing
opportunity to uncover the story of their biogeography and systematic and population
biology.

In my relatively short research career, I have enjoyed the field and international travel,
visiting museum collections and curators, working in the laboratory, publishing in sci-
entific journals and presenting at conferences. I have the lucky opportunity to work
with Prof Chris Austin—one of Australia’s greats in crayfish biology (Astacology)
and evolutionary biology. My lab and field colleagues such as Dr Graham Hosie (Aus-
tralian Antarctic Division), Dr Thomas von Rintelen (Berlin Museum), Dr Adam Miller
(Melbourne Uni) and Dr Daniel Ierodiaconou (Deakin University) have been incredi-
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ble people to work with and it has been fantastic to get the chance to live and work in
remote locations such as Darwin (which is where I carried out most of my research dur-
ing the lab and write up stages of my Ph D), Warrnambool, Hobart, Austria, Antarctica,
Papua, Indonesia and Vietnam.

I believe that my career has so far been an exciting one and I hope that it continues
to stay this way. I can highly recommend systematic biology to all those looking for
an exciting career path. It is a field of research that will take you to unexpected and
demanding places and will open your eyes and mind to the ways of the world!

Mark Schultz

Schultz MB, Smith SA, Richardson AMM, Horwitz P, Crandall KA, Austin CM. 2007. Cryptic diversity
in Engaeus Erichson, Geocharax Clark and Gramastacus Riek (Decapoda: Parastacidae) revealed by mito-
chondrial 16S rDNA sequences. Invertebrate Systematics 21: 569–587.

Schultz MB, Ierodiaconou DA, Smith SA, Horwitz P, Richardson AMM, Crandall KA, Austin CM. 2008.
Sea-level changes and palaeo-ranges: reconstruction of ancient shorelines and river drainages and the phy-
logeography of the Australian land crayfish Engaeus sericatus Clark (Decapoda: Parastacidae). Molecular
Ecology 17: 5291–5314. doi: 10.1111/j.1365-294X.2008.03996.x

Schultz MB, Smith SA, Horwitz P, Richardson AMM, Crandall KA, Austin CM. 2009. Evolution under-
ground: a molecular phylogenetic investigation of Australian burrowing freshwater crayfish (Decapoda:
Parastacidae) with particular focus on Engaeus Erichson. Molecular Phylogenetics and Evolution 50: 580–
598.

10th Invertebrate Biodiversity and Conservation Conference

St Mary’s College, Melbourne, 4–7 December 2011

The 10th Invertebrate Biodiversity and Conservation Conference will be a joint meet-
ing with the Society of Australian Systematic Biologists (SASB) and will be held at
St Mary’s College, the University of Melbourne, from 4 to 7 December 2011, with an
associated workshop planned on Thursday 8 December. St Mary’s College is ideally
located on the northern part of the campus of the University of Melbourne and very
close to the restaurants of Lygon Street, Carlton. The Carlton Gardens campus of Mu-
seum Victoria and the Victoria Market are within a 15 minute walk as is the Melbourne
CBD.

The following symposia are scheduled, but individual presentations on other topics are
welcomed. Abstract for all presentations are due 30 September 2011.

• Tropical invertebrate diversity—From rainforest to reef

• Species in principle and in practice —Morphological and genetic approaches to
defining species boundaries

• Assessing and countering threats to invertebrates

• Biodiversity and biosecurity—Can one work without the other?
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The program will take place over the following dates:

• Sunday 4 Dec 2011—Registration and icebreaker

• Monday 5 Dec 2011–Tuesday 6 Dec 2011—Conference presentations

• Tuesday 6 Dec 2011—Conference dinner

• Wednesday 7 Dec 2011—Final day of conference presentations

On Thursday 8 Dec 2011 a separate workshop “Invertebrate conservation” is being
held which will involve interested conference registrants but will also involve other
participants such as representatives of state and federal conservation agencies. For
further details check out the conference website (http://ibcc2011.org/).

Samuel Brown

Bootstrap Camp at Mt Kaputar

Since 2007, Lyn Cook’s Lab from The University of Queensland (UQ) and Mike
Crisp’s Lab from The Australian National University (ANU) have met annually some-
where in between the two universities to have a lab “retreat”. The first time the groups
met, one of the members christened the retreat “bootstrap camp” in reference to a mea-
sure of support used in phylogenetic analyses, and the name stuck. In 2010, five days
of bootstrap camp were spent in Mt Kaputar National Park, and a 6th day was spent in
the Pilliga Scrub.

Pink slugs in the forests

The plateaus of Mt Kaputar National Park, near Narrabri in NSW, were apparently
formed 17–21 million years ago. The park contains several different habitats that are
home to hundreds of species.

Within Mt Kaputar National Park, the unique pink slug Triboniophorus graeffei (an
unusual form of the red-triangle slug) can be found in the subalpine eucalypt forests.
Bort Edwards found the first pink slug of the trip. It is thought that the colour of the
slugs acts as camouflage, because it is a similar shade to fallen eucalypt leaves. The
slugs crawl up the eucalypt trees at night to feed, and can be found crawling back down
the trunks in the morning (particularly if it’s been wet or foggy).

Research talks

Each member of the two lab groups presented a talk to everyone about their current
research—this year’s topics included pollen, wasps, butcherbirds, coconuts, broad-
leaved paper-barks, cycads, waratahs, eucalypts, and scale insects.

Cooking with the ’roos

We slept in National Park cabins near the summit of Mt Kaputar and everyone took
turns cooking for the entire group with two or three “cooks” each night. We had won-
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Renowned pink slugs in Mt Kaputar National Park. The photo on the right shows a slug
next to a dead eucalypt leaf. Photos: Andy Wang

Some members of the Cook and Crisp labs on top of Mt. Lindesay in Mt Kaputar National
Park, November 2010. Left to right: Andy Wang (UQ), Bort Edwards (UQ), Anna Kearns
(UQ), Gunter Maywald (UQ), Andrew Thornhill (ANU), James Ingham (UQ), Penny Mills
(UQ), Mike Crisp (ANU), Melita Milner (ANU), Lindsay Popple (ANU), Paul Lin (UQ) and

Bee Gunn (ANU). Photo: Lyn Cook.
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derful food, such as a Mexican night with tacos and tortillas. Kangaroos were the usual
visitors while we were cooking. They were quite interested in our kitchen activities
and seemed particularly fond of the old discarded charcoal from the BBQ.

Every dinner came with entrée, main course and dessert. Port, wine and chocolate were
the preferred choices during the usual post-dinner chat.

Exploring Mt Kaputar and beyond

Four bushwalks were completed in the park. The main goal of the bushwalks was
to observe the biodiversity and geology of Mt Kaputar National Park—particularly
eucalypt beetles (paropsines), gall-inducing scale insects, sawflies, birds, eucalypts and
cycads.

A day trip was also organized to the Pilliga Scrub, several hours south of Mt Kaputar.
We had several stops along the tracks, so everyone could get out and explore. The
Pilliga Scrub is a lot drier than the rainforest and wet sclerophyll forests of Mt Kaputar
National Park, and consequently has different species of cycads, eucalypts and insects.

Scenery and weather

The scenery at Mt Kaputar National Park was gorgeous. We took photos and enjoyed
stopping for lunch on top of some of the peaks. Unfortunately, sometimes these beau-
tiful walks were interrupted by one or two downfalls of rain.

The Mt Kaputar and Pilliga Scrub bootstrap camp was an exciting experience, filled
with amazing sites, beautiful scenery and a huge diversity of life. Now it’s time to plan
for the next camp!

Andy Wang

Penny Mills

School of Biological Sciences, The University of Queensland, Brisbane

8th Systematics Association Biennial Conference

Queen’s University, Belfast, 4–8 July 2011

Registration is open for the 8th biennial conference of the Systematics Association,
held for the first time in Northern Ireland! There is an exciting programme that in-
cludes both plenaries and thematic symposia, as well as a large number of contributed
sessions. Currently scheduled symposia include:

• Next Generation systematics—Studying evolution and diversity in an era of ubiquitous
genomics

• Arthropod systematics: are morphology, palaeontology and molecules coming together?

• Algal systematics: Where next?

• Advances in using museum specimens and ancient DNA in systematics research
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View toward Sawn Rock in Mt Kaputar National Park. Photo: Andy Wang.

Adult sawfly on flower in Mt Kaputar National Park. Photo: Andy Wang.
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Symposia will include a mixture of talks from invited speakers and other contribu-
tions. The conference also presents excellent opportunities for contributed papers on
any aspect of systematics and is a great forum for students and young researchers to
present their work. For further details, including information on accomodation and
travel, please see the conference website (http://www.systass.org/biennial2011/).

The organisers gratefully acknowledge the support of the British Phycological Society,
Cambridge University Press, Genetics Society, The Linnean Society of London, and
Queen’s University Belfast.

Juliet Brodie, President

James Cotton, Programme Officer

Peter Olson, Treasurer

Christine Maggs, Local Organiser

Implications to go by the bored

(Sydney Daily Telegraph, 31 November 2011)

by science reporter Chloe Hammer

In what is believed to be a world first, a Sydney biodiversity conference has banned the
phrase ‘implications for conservation’ from conference posters and presentations.

Organisers of the Ecosystematics and Conservation Conference say the ban is long
overdue.

‘It’s time for people to put up or shut up,’ according to co-organiser Prof Dan Gimlet
of the University of Melbourne.

‘If they have results that mean conservation practice should be changed,’ said Gimlet,
‘then they have an obligation to say what the changes ought to be.’

Co-organiser Dr Shirley Drillbit of the Australian National University agrees. ‘I must
have heard a hundred of these “implications” talks over the years,’ she said. ‘Who
do the speakers think is going to leap into action when their talk is finished? And do
what?’

Not everyone is pleased with the new conference policy. Associate Prof Nigel Awl of
Griffith University says the ban is offensive.

‘I’ve got three students besides myself on the conference program, and we all conclude
our talks with, “These results have important implications for conservation,” ’ said Awl.

‘Without that, where’s our punchline? Besides, “implications for conservation” is in all
our grant applications. It’s half the reason we get money. Nobody funds biodiversity
studies per se. They’ve got to be biodiversity qua conservation.’

‘Qua pfui’, responded Gimlet. ‘The big lesson from biodiversity work is that there’s
life out there we didn’t know about. Want to conserve it? Fine, then tell the land
or water manager or owner what to do. If you don’t know, nobody else does, and
“implications” is meaningless.’
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Awl complains that the conference organisers are demanding too much.

‘I’m not a conservation biologist,’ he said. ‘How do I know what the implications are?
I just know that they exist. It stands to reason that the more we learn, the more we
should use what we learn in conservation. Maybe I could come up with something if I
had additional funding, specifically for conservation.’

Drillbit said the case for such funding would have to be carefully phrased if it was made
at the conference.

‘We’re also thinking of putting restrictions on “Further study is needed,” ’ she said.
’Recently we looked at 50-odd ANU biology theses. More than 95% began with “Very
little is known” and ended with “Further study is needed.” Not even Mills and Boon
writers stick so closely to a formula. I think people can do better.’

Bob Mesibov

2nd National Postgraduate Training Workshop in Systematics

The University of Adelaide, 25–30 September 2011

This workshop will include advanced level training in phylogenetic methods, imaging
techniques, barcoding, systematics theory, nomenclature and the taxonomic process,
collection management, databases, publishing results, finding a job, and much more.

The workshop is designed for PhD students in the first and second years of their project,
but applications will be accepted from anyone who has had less than three years of
candidature. It is specifically designed for students undertaking projects that have a
biological systematics component or are broadly relevant to systematics. Funding is
available to assist students attend the workshop, but there is a maximum of 30 places
available only to students enrolled in Australian and New Zealand Universities.

The deadline for expressions of interest is 6 June 2011. Please email expressions
of interest to: michelle.guzik@adelaide.edu.au: Include your name, institution and
School/Department, project title and brief 100 word description, years/months of can-
didature, name of primary supervisor and their email address.

The workshop is sponsored by Australian Biological Resources Study, the Australian
Centre for Evolutionary Biology & Biodiversity (The University of Adelaide) and the
Taxonomy Research & Information Network

Andy Austin

The Reach of Banksia

Each of the ‘Fringe Taxonomy’ articles in the last two issues of Banksia got a re-
sponse from a person featured. Dr Hüseyin Özdikmen emailed from Turkey, and Trevor
Hawkeswood phoned me at home. The former seemed content with my presentation.
The latter was not happy with what I had written.
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Spider guru Norman Platnick is also unhappy. His supplement to

Jiménez, M.L., Platnick, N.I. and Dupérré, N. 2011. The haplogyne spider genus Nop-
sides (Araneae, Caponiidae), with notes on Amrishoonops. American Museum Novi-
tates 3708 :1-18. (doi: 10.1206/3708.2)

begins:

‘In what may be the most preposterous “paper” ever produced in spider taxonomy,
Dewanand Makhan and Somayeh Ezzatpanah recently attempted to establish “A new
spider family, Hawkeswoodidae fam. nov. and Amrishoonops amrishi gen. et sp. nov.
(Araneae) from Suriname.”’

Bob Mesibov

Fourth International Barcode of Life Conference

University of Adelaide, 28 November–3 December 2011

The 4th International Barcode of Life Conference will be held at the University of
Adelaide, in Adelaide, Australia, from 28 November to 3 December 2011, in partner-
ship with the Consortium of the Barcode of Life. The main scientific sections will be
held on 30 November–3 December, with 28–29 November set aside for pre-conference
workshops.

The International Barcode of Life Conferences is an important science and policy event
that takes place every two years. The conference allows participants and sponsoring or-
ganizations to promote partnerships which enable the international scientific and pol-
icy community to better understand, quantify and manage their biodiversity with DNA
Barcodes.

The 2011 Adelaide Conference will be the first international barcode conference held
in the Southern Hemisphere. It will address a range of Barcoding applications and
developments, including: illegal wildlife and timber trade; pest and disease diagnos-
tics; forensics; quarantine identifications; environmental monitoring and assessment;
animal, plant and microbial systematics; and Beyond Barcoding.

The deadline for the submission of abstracts has been extended to 15 June 2011. Please
see the conference website (http://www.dnabarcodes2011.org) for more details.

Andy Austin

Creating line drawings in Inkscape

In the second issue of Banksia, I wrote a review of the free vector-graphics program
Inkscape (http://www.inkscape.org). The following is a short tutorial showing the pro-
cess I use to create publication-quality graphics using the program.

1. Import picture: Take or create a picture of the structure you want to illustrate.
This can come from a digital photograph or a scanned copy of a hand line draw-
ing from a drawing tube. It is possible to draw directly into Inkscape by mouse
or drawing tablet, however I have neither the skills for the first, or the equipment
for the second. Import your picture by File > Import (Ctrl + I) (Figure 1).

Banksia: The newsletter of the SASB
Issue 6 (June 2011)

http://www.sasb.org.au
pg 11

http://dx.doi.org/10.1206/3708.2
http://www.dnabarcodes2011.org
http://www.sasb.org.au/banksia/Banksia_02_May_2009.pdf
http://www.inkscape.org
http://www.sasb.org.au


2. Trace outline: Roughly trace the outline of the structures of interest using the

pencil tool (P) (Figure 2).

3. Simplify outline: The rough outline created above can be simplified and smoothed
by Path > Simplify (Ctrl + L). Simplify as many times as needed.

4. Manipulate outline: The now smoothed outline can be manipulated using the

nodes tool (F2). Move the nodes and handles to exactly match the outline
(Figure 3).

5. Fill and stack objects: Create the final picture by filling each object with appro-
priate colour and changing line width and style Object > Fill and Stroke
(Ctrl + Shift + F). Move objects up and down using Object > Raise (PgUp)
and Object > Lower (PgDn) (Figure 4).

Why do it? Especially as the first step involves having a picture to begin with? Photos
frequently show excessive detail, important structures can be obscured, and depth of
field can be a problem too. Line drawings simplify the detail to show what is especially
important. They can also easily account for obstruction and orientation. Hard-copy,
inked drawings can be scanned into bitmap format, thereby gaining the benefits of
portability and the ease of subsequent manipulation that computer graphics provide.
However, bitmap images suffer from scalability issues (Figure 5). Vector graphics
encode picture data as coordinates and paths, and can be scaled indefinitely without
loss, or looking pixelated.

Inkscape saves pictures in the scalable vector graphics (SVG) format, which is based on
XML. As more internet browsers develop SVG support it will become straightforward
to post these graphics on webpages. It is also simple to convert SVG to PDF or EPS
format, both of which are common formats for publication.

Samuel Brown

About the Society

SASB Officers:
Bob Mesibov (President)
mesibov@southcom.com.au
Penny Mills (Vice-President)
Andrew Thornhill (Secretary)
andrew.thornhill@anu.edu.au
Samuel Brown (Newsletter Editor)
sam.brown@lincoln.ac.nz
Steve Cooper (Treasurer)
Lyn Cook
Michael Braby
Mike Crisp

The Society:

The Society of Australian Systematic Biologists is
open to all people who utilise the science of bio-
logical systematics as a basis for the study and un-
derstanding of nature. The Society is a non-profit
inter-disciplinary organisation whose purposes are
to promote the scientific study of biological system-
atics and to disseminate scientific and educational
information related to its fields of interests.

Membership:

Membership is free. Details are available on the society
website (http://www.sasb.org.au/contacts.html) and from
the secretary.
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Figure 1. Screenshot of Inkscape showing imported picture—an antenna of Carpophilus
robustus. Photo: Samuel Brown

Figure 2. Roughly traced anntenomeres.
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Figure 3. Manipulating smoothed outlines using the ‘Nodes’ tool.

Figure 4. Changing the colour and width of the outlines.

Figure 5. Finished drawing of antenna, showing the difference between vector graphics
format (left), and the same image exported in bitmap format (right). To really see the

difference, view at increased magnification.
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